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地球表面下，储藏着非常丰富的地热能。地热能以其清洁、高效、稳定、分

布广、可再生、应用范围广等优势，成为未来重要的新能源。地热模拟（Geothermal 

Simulation）也逐渐成为热门研究课题。本讲义主要从实际操作的角度为用户演

示如何建立地热模拟模型并分析结果。 
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一、地热能的分类 

根据地热能赋存埋深和温度，地热能可分为三类：浅层地热资源、水热型地

热资源及增强型地热资源（Enhanced Geothermal Systems(EGS)），也叫干热岩

（HOT DRY ROCK）。 

浅层地热资源：指蕴藏于地表一定深度（一般小于 200m)范围内岩土体、地

下水和地表水的热能，主要通过热泵进行利用。 

水热型地热资源：指蕴藏在地下水中，通过天然通道或人工钻井进行开采利

用的地热能。 

干热岩地热资源：指埋深 3000m、温度大于 200°C，内部不存在流体或仅有

少量地下流体的有较大经济开发价值的热储岩体。干热岩的地热开发就需要从一

口井注入冷水，在地下换热，然后热能以热水或者蒸汽的方式从另一口井采出。 

二、地热模拟的机理 

地热模拟需要考虑的主要机理包括 3 方面： 

1）热动力学参数，也就是热焓； 

2）传热参数，即热传导和对流； 

3）流体流动，包括考虑基质、天然裂缝和水力压裂裂缝的流动。 

干热岩模拟时还需要考以下因素： 

1）考虑相态变化（水的挥发和凝析）； 

2）热损失（边界和井筒）； 

3）流动能力（水力压裂裂缝，压裂体积 SRV）； 

4）模型类型选择：单孔模型，双孔模型，还是双渗模型； 

5）工作制度的敏感性，注采速度等； 

6）热流固耦合等。 
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三、模拟案例（一）干热岩（HDR）储层模拟 

STARS 模拟器凭借其在油藏热采模拟的绝对优势，在地热模拟方面有着得

天独厚的条件，因此成为地热模拟的首选软件。下面通过一系列实际操作流程来

演示地热模拟的过程。 

典型的低孔低渗干热岩储层，开采时一般需要进行水力压裂。Builder 前处

理模块从 2016 版开始才能创建 STARS 模型的水力压裂裂缝。为了方便 2016 版

之前用户使用 STARS 模拟地热开发，本文先用 IMEX 黑油模拟器来生成水力压

裂裂缝，然后转成 STARS 模型来模拟热能的采出效果，以及评估采出的热量。

模型中有两口井，一口用于注入冷水，另一口用于采出热水。最后计算 10 年时

间采出的热量。 

2016 版及之后的版本，可以直接用 Builder 创建 STARS 模型的水力压裂裂

缝。用户可以直接建立 STARS 地热开发模拟模型，不需先建立 IMEX 模型再转

STARS，我们将后续推出相关讲义。 

1. 地热储层建模 

1） 双击 Launcher 中的 Builder 图标，选择 New，新建一个模型。 

2） 在弹出的对话框中选择： 

• IMEX 模拟器，SI 单位，Single Porosity 单孔模型 

• 开始日期 2000-01-01 

3） 单击 OK 两次。 
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4） 在 Builder 界面左侧的树视图，点击 Reservoir → Create Grid 

→ Cartesian，创建笛卡尔网格。 

5） 设置网格数为：20（I 方向）×10（J 方向）×10（K 方向）。 

6） 在 I 方向框中输入 20*50（I 方向上的 20 列网格步长都是 50

米）。 

7） 在 J 方向框中输入 10*50（J 方向上的 10 行网格步长都是 50

米）。点击 OK。 

8） 单击顶部工具栏上的按钮 ，将鼠标模式更改为探针模式

（Probe Mode）。 

9） 点击屏幕顶部中间的 Specify Property（定义属性）按钮，打开

General Property Specification（通用属性设置）表格，在 Grid Top 的

Layer 1 中输入顶层深度 2000（m），在 Grid Thickness 的 Whole Grid 中

输入 50（m），每一层都为 50m。 

 
10） 点击 OK，接下来会弹出 Block / Corner Value Calculation 属性计

算窗口，此窗口主要是核实需赋值的属性，缺省设置即可。点击 OK。 

11） 将视图从左上角 IJ-2D Areal 更改为 3D View 并显示 Grid Top 属

性。 
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12） 在工具栏中单击 Rotate Reservoir 按钮 ，按住鼠标左键并使

用光标移动模型来旋转显示。按住鼠标左键并同时按住 Ctrl 键，将鼠

标拖到屏幕底部可放大显示，或将鼠标拖到屏幕顶部可缩小显示。也

可以通过向前滚动鼠标滚轮或向后滚动来缩小和放大显示。 

13） 重复上面的操作，为孔隙度 Porosity 和渗透率 Permeability 赋

值。点击 Specify Property（定义属性）按钮，通过下拉菜单找到

Porosity 和 Permeability I，在 Whole Grid 中分别输入以下数值： 

• Porosity = 0.01 

• Permeability I = 0.01 mD 

 
 

14） 选择 Permeability J 并在 Whole Grid 框中单击右键。选择

EQUALSI，OK。对 Permeability K 进行同样的操作。以上操作即表明

三个方向的渗透率相同。 

15） OK 退出。在 Block/Corner Value 计算窗口中点击 OK。在 CMG 

2018 版，此窗口也可以通过点击 Calculate Property（计算属性）按钮

来打开。 

16） 双击树视图菜单底部区域的 Rock Compressibility（或者

Reservoir → Rock Compressibility 打开），在 CPOR（岩石压缩系数）

框中输入 1.20E-5，在 PRPOR（参考压力）框中输入 20000，然后点击

OK，对应单位将自动填充。现在 Reservoir 部分应该有绿色标记，表明

已完成定义。 

17） 保存模型。点击 File→Save As，将模型另存为

EXERCISE_1_HDR_IMEX.dat。 
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2. 创建 PVT 数据 

由于 CMG 软件是为石油和天然气藏开发设计的，因此在 PVT 部分，这些

组分将按照常规的做法来生成。但是后面我们将只使用水组分，因为这是地热储

层的主要组分。 

18） 点击树视图中的 Components 选项卡，然后双击 MODEL。 

 
19） 选中 Launch Dialog to Create a Quick BLACKOIL Model Using 

Correlations，单击 OK 按钮。 

 

注意：本节中输入的一些信息用于生成 PVT 模型，可能与地热模拟无关。 

 

20） 在弹出对话框中输入以下信息： 

• 在 Reservoir Temperature 框中输入 160（缺省单位制是 C）； 

• Generate data up to maximum pressure of 中输入 35000（缺省单位制

是 kPa）； 

• 对于 Bubble Point Pressure Calculation，选择 Value Provided 选项，

并输入 5000 kPa； 

• Oil Density at STC 中，选择 Stock tank oil gravity (API)作为要使用

的密度类型，并在数据输入窗口中输入值 20； 
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• 改变 Gas Density at STC 以显示 Gas Gravity（Air = 1），并在数据输

入窗口中输入 0.85； 

• 在 Reference Pressure for Water properties 框中，输入 20000 kPa； 

• 其余选项保留为其缺省值，然后单击 OK。 

 
21） 在树视图中双击 PVT Region：1，并选择 PVT Table 选项卡查看

BLACKOIL PVT 数据。 

22） 取消 Include Oil Compressibility in PVT Table，即表中不包含油

相压缩系数。 

 
23） 转到 General 选项卡并在下面的 undersaturated Co 下输入常数值

= 4.35113e-006，输入后自动跳出单位 1/kPa。 
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24） 点击 OK，关闭 PVT 表窗口。 

25） Component 部分现在应该有一个绿色的标记，表明流体部分设

置已完成。 

3. 创建相对渗透率数据 

HDR 是一种没有流体的干储层，完全是热岩。在地热开发工程中，会进行

水力压裂，而冷水的注入会产生热水的流动，并采至地面。在本节中，我们将创

建一组相对渗透率曲线，以模拟冷热水的流动。 

26） 点击左侧菜单中的 Rock-Fluid→Create/Edit Rock Types。在弹出

的窗口中点击 按钮并选择 New Rock Type。 

27） 在 Relative Permeability Tables 选项卡上，点击 Tools → 

Generate Tables using Correlations。 

 

 

28） 为生成相对渗透率曲线，输入以下参数。 

SWCON 0.10 

SWCRIT 0.15 

SOIRW 0.4 

SORW 0.4 

SOIRG 0.2 

SORG 0.2 

SGCON 0.05 
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SGCRIT 0.05 

KROCW 0.8 

KRWIRO 0.4 

KRGCL 0.001 

KROGCG 0.8 

所有指数 2.0 

 

29） 点击 Apply，然后 OK。再次点击 OK，退出 Rock Types 窗口，

此时在 Builder 的窗口出现一组相对渗透率曲线。 

30） 树视图中 Rock Fluid 部分应该有一个绿色的标记，表明此部分

设置已完成。保存文件。此时保存按钮是灰色的，点击树视图 I/O 

Control，就可以保存了。 

 

4. 定义初始化条件 

31） 点击树视图上的 Initial Conditions 按钮，双击 Initial 

Conditions。 

32） 选择 Water, Gas 作为储层中的初始流体来进行重力-毛细管平衡

计算。 

33） 在相应区域中输入以下数值： 
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• 在 REFPRES（参考压力）框中输入 20000（kPa） 

• 在 REFDEPTH（参考深度）框中输入 2250（m） 

• 在 DWGC（油气界面）框中输入 4000（m） 

• 在 PB（恒定泡点压力）框输入为 5000（kPa） 

 

注意，在初始条件下，干热岩 HDR 中不含液体。为了模拟这种情况，我们

将使用不可流动气来初始化模型。 

34） 点击 Apply，然后 OK。 

35） 现在回到 Builder 主窗口，除了 Wells＆Recurrent 选项卡外，所

有选项卡在树视图中都显示绿色标记。 

36） 保存文件。 

5. 创建井、生产制度和射孔 

前面创建了静态模型后，现在需要将井射孔和约束条件信息加入到模型中。 

37） 点击 Wells＆Recurrent 选项卡，右键单击树视图中的 Wells 并选
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择 New。 

38） 将新井命名为 PROD，将 Type 更改为 PRODUCER。选择

Constraints 选项卡，并选中 Constraint definition 复选框。输入约束条件

OPERATE，BHP bottom hole pressure，MIN，10000, CONT REPEAT  

39） 重复之前的步骤以添加具有第二口井： 

• 井名：INJEC 

• 井的类型：INJECTOR MOBWEIGHT 

• 约束条件：OPERATE，STW surface water rate，MAX=100 m3/day 

• INJECTED FLUID（注入流体）：WATER 

40） 点击 OK 从 Create New Well 界面退出。 

41） 井 PROD 和 INJEC 应该出现在 Well＆Recurrent 树视图中。井

名旁边有红点，表示存在数据问题。 

42） 右键单击其中一口井，然后选择 Validate 以显示错误或警告消

息。该消息表明没有有效的射孔，点击 OK 关闭窗口。 

43） 单击 PROD 旁边的+号并双击 2000-01-01 PERF。 

44） 在弹出的 Well Completion Data (PERF)界面中，选择

Perforations 选项卡。 

45） 点击插入节点按钮 ，并输入地址 4:14 4 6，注意其中冒号

为英文字符，点击 Apply。 
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46） 从下拉菜单中选择 INJEC 注入井，在弹出的对话框中单击 Yes

完成生产井的射孔。 

47） 重复前面 PROD 的射孔步骤，在网格地址栏输入 4:14 7 6，点

击 Apply，即可为注入井创建一组射孔。点击 OK 退出当前射孔窗口。 

 

48） 将视图更改为 IJ-2D Areal 平面显示，用鼠标调至第 6 层，查看

井的射孔： 
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在模型中添加一组日期 

49） 点击树视图中的 Wells＆Recurrent 并双击 Dates 打开窗口，点击

右侧 Add a range of dates 按钮添加一组日期。 

50） 在 To 日期后面的日历中选择 2010-01-01。其他缺省设置，点击

OK。在 Simulation Dates 窗口。点击最后一个时间 2010-01-01 的复选

框 set STOP，然后 Close 当前窗口。 

 

6. 添加水力压裂裂缝 

干热岩储层通常非常致密，需要通过水力压裂方可注入冷水和热出热水。

Builder 前处理模块的水力压裂（Hydraulically Fractured Wells）向导可进行局部

网格加密，设置网格大小接近于实际的裂缝宽度，比表皮因子更能精确地模拟裂

缝。  

51） 点击 Wells & Recurrent → Hydraulic Fracturing（2013.10 以及

之前版本选择 Hydraulically Fractured Wells）。 
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52） 弹出 Hydraulically Fractured Well 水力压裂向导。点击向导顶部

的 Non-Darcy Option 非达西选项卡，Non-Darcy Flow Option（非达西流

动选项）中选择 General Correlation。下列缺省数值可用于油气水相： 

 Αlpha： 1.485e9 

 N1： 1.021 

 N2： 0 

 Forch_max： 10000 
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注意：IMEX 中有四个非达西流动选项。General Correlation 选项表明非达西

流动将是各相饱和度、孔隙度和渗透率的函数，更多信息请参阅 IMEX 手册。 

53） 切换到 Fractures 选项卡。从列表中选择 INJEC 下的日期 2000-

01-01，然后点击 New Planar Fracture Stage（2013.10 及之前版本点击

Tools → Add New Fracture）。在 INJEC 井的 2000-01-01 日期下面出现

一个叫做 INJEC - Frac 的新裂缝。 

54） 在 PROD 下点击 2000-01-01，重复前面的步骤添加新的裂缝。 

55） 选择左侧窗口 INJEC → Planar Stage 1，点击 Fracture template

右侧 Edit 按钮（这个界面与 2013 版本以及之前版本界面相差较大，大

家可根据下面第一个截图进行设置），设置以下属性： 

• I 方向的加密数量：5 

• J 方向的加密数量：5 

• K 方向的加密数量：3 

• 裂缝宽度：0.001 m 

• 渗透率：30000 mD 

• 网格加密方向：J 
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• 裂缝半长：75 m 
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56） 单击 Apply，切换到 Fractures 选项卡，在右侧 Select 

Perforations 中选择 All Perforated Layers（所有射孔层）。点击 OK。 

 

57） 重复前面的步骤为生产井 PROD 添加裂缝，并使用相同的属

性。或者点击 PROD 在 2000-01-01 时间下的 Planar Stage 2，然后在

Fracture Template 中选择 Planar Template，在 Select Perforations 中选择

All Perforated Layers，点击 Apply，左侧窗口显示为两口井创建的裂

缝。 
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58） 点击 OK 回到 Builder 界面。可放大模型以查看裂缝网格的细化

情况，以及对应裂缝的网格，渗透率和 Forchheimer 方程修正

（Forchheimer Equation Beta Correction）属性进行相应的更改。再次保

存文件。 
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59） 点击树视图中 Numerical，双击 Numerical Controls。调整以下

设置后保存文件： 

• DTWELL：1e-4  

• DTMIN：1e-6  

• NCUT：15 

7. 计算 IMEX 模型 

60） 首先在 Launcher 中找到文件 EXERCISE_1_HDR_IMEX.dat，然

后将其拖放到 IMEX 图标上并释放鼠标。在弹出的窗口上选择 Run 

Immediately 立即计算按钮。 

61） 这将打开一个 MS-DOS 窗口并显示运行进度。计算完成后，

MS-DOS 窗口将终止并显示结果的简要摘要。 
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8. 在 Results Graph 中查看结果 

运行模型后，可以查看结果。 

62） 将 EXERCISE_1_HDR_IMEX.irf 拖到 Results 3D 图标，在下拉

菜单中选择 Ternary 三相饱和度属性，2000-01-01，选择显示第 6 层属

性。 

 

 

63） 为了模拟热干岩中可忽略的流体流动的情况，对模型进行初始

化时，根据相渗曲线定义较低流度的不可流动的水和气。 

64） 回到 Launcher，用 Results Graph 打开

EXERCISE_1_HDR_IMEX.irf，为生产井 PROD 创建一个曲线图，并添

加两条曲线展示天然气和水的生产情况。将体积单位更改为用于天然

气的 MMSCF 和用于水的 bpd（右键 Properties→Units，选中 User 

Defined Unit System，即可修改对应的单位制）。 
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65） 结果表明，由 HDR 开采出的气体可忽略不计，并且由于在这

两口井已进行水力压裂，产水量来自注入井。 

9. 将 IMEX 模型转换为 STARS 模型 

66） 在 Builder 中打开文件 EXERCISE_1_HDR_IMEX.dat。 

67） 点击菜单 File → Convert Simulator ….，选择 STARS。弹出对

话框，询问是否保存当前文件，单击否（N）。 

68） 在出现的新窗口中输入新模型的名称和位置。确保文件的位置

是 STUDENT SOLUTIONS 文件夹。输入以下名称：

EXERCISE_1_HDR_STARS.dat，并选择 Convert from Black oil model

（从黑油模型转换）选项。点击 OK。 
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69） 弹出新窗口，显示 STARS 无法识别的关键字，可浏览一下。点

击 OK。 

 

70） 在弹出的有关油水界面的警告信息上单击 OK。 

71） 弹出 STARS Import Black Oil PVT 窗口，从可用压力列表中选

择饱和压力。点击 Set button 设置按钮然后从表格中选择，点击饱和压

力 5000 kPa。现在可点击 Next button 下一步按钮。 
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72） 在步骤 2：输入 STARS 组分数据窗口中保留缺省值，然后单击

下一步： 

 

73） 在步骤 3 中，在气液 K 值温度相关性下，使用缺省值。该值控

制温度变化时泡点（即饱和压力）和 GOR 的变化。点击 Next。 

74） 在粘温关系表中输入以下信息。注：160C 的油相粘度值来自

IMEX 生成的表格。STARS 模拟器要求输入两个以上的温度，因而加

入第二行粘度数据。 

 

 
75） 请注意，组分系统部分选择包含 3 个组分（水，脱气油和溶解

气）的 Live Oil 系统（如果选择 Dead Oil 系统，则只会添加 2 个组分

（水和脱气油）。溶解的气体量将由油相中溶解气组分的初始摩尔分数

确定（MFRAC_OIL）。点击 Next。 

76） 此时将弹出一条消息，确定使用计算出油相的热膨胀系数

（Ct）数值。单击 OK 以使用此值。 
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77） 步骤 5 用于统计 IMEX 黑油相关式和 STARS K 值之间的拟合情

况。将此窗口移到侧面可以查看拟合图。请注意步骤 5 面板中窗口的

拟合误差值。通过展开并点击各种可用图表来检查拟合质量。鉴于可

用的有限 PVT 数据，这些拟合精度是可接受的。请注意，气体粘度与

压力曲线似乎与黑油 PVT 数据不匹配。这是因为 STARS 中气体粘度

与温度和组分有关，但气体粘度与压力无关（见关键词 AVG 和

BVG）。普遍认为，气体粘度随压力的变化并不像温度和组成的变化那

么明显。 
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78） 点击 Next，继续执行第 6 步：完成！该窗口显示了油相中两个

组分随压力变化的粘度值。这些组成很重要，因为模型需要在参考压

力和参考深度下以适当的摩尔分数进行初始化。  

79） 点击 Finish 关闭窗口。 

80） 选择 Component → Liquid Viscosities 下选择液相粘度选项。从

表格中选择与温度高于 160°C 相对应的行，通过 Cut 操作将其删除

（见下图）。向导还生成了不同压力下的粘温表，模拟地热不需要，点

击粘温表上方的 Single Table，点击 Apply。 
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81） 切换到 Component definition 组分定义选项卡，点击 Dead_Oil

并点击右下角 Delete Selected Component 按钮将其删除。点击 Apply，

OK。 

82） 保存文件。 

10. 定义 STARS 模型热物性参数 

83） 在树状视图中的 Reservoir 部分双击 Thermal Rock types。切换

至 Thermal Properties 选项卡并输入以下值： 

• 体积热容（岩石）：2.35e6 J/（m3*C） 

• 温度相关系数（岩石）：0 J/（m3*C*C） 

• 相热传导混合规则：COMPLEX 

• 岩石导热系数：2.6e5 J/（m*day*C） 

• 水相导热系数：5.6e4 J/（m*day*C） 

• 气相导热系数：2850 J/（m*day*C） 
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84） 切换到 Overburden Heat Loss（上覆岩层热损失）选项卡并输入

以下信息： 

• 上覆岩层容积热容：2.35E06 J/（m3*C） 

• 下覆岩层容积热容：2.35E06 J/（m3*C） 

• 上覆岩层导热系数：1.5E05J/（m*day*C） 

• 下覆岩层导热系数：1.5E05J/（m*day*C） 

 

85） 点击 Apply，再点击 OK。 
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11. 定义井和动态数据 

86） 在 Wells＆Recurrent（井和动态）下，双击 Wells，选择注入井

INJEC → Injected Fluid（注入流体）部分，输入 Water（水）的摩尔

分数值为 1.0，温度为 86 C，代表注入冷水的温度。点击 Apply，然后

OK。 

 

12. 输入/输出控制（I / O Control）部分 

87） 在树状视图中选择的 I / O Control，双击 Simulation Results 

Output（模拟结果输出）。 

88） 弹出窗口的 OUTSRF 中，将井信息 Well 更改为 Layer All（输

出所有射孔层的值）。点击绿色加号，并添加另一个 Well 输出，并选

择 COMPONENT ALL（输出所有组分值）。点击绿色加号，添加一个

Special。点击 OK。 
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89） 点击 Special 后的 Select 按钮，在弹出的窗口的第三栏中选择

WELLENERGY，Well 1 选择 PROD，Quantity / Option 选择 RATE。 

90） 当鼠标在 WELLENERGY 变量上时，点击顶部的 Insert → 

Insert and copy a row，插入复制行，将 Well 1 改为 INJEC。 

 

91） 按照同样方法再复制粘贴两次，输出 INJEC 和 PROD 累积注入

和产生的热量 Cum。OK。 
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13. 设置初始化方式、摩尔分数和流体粘度混合规则 

92） 切换到 Initial Conditions → Initialization Settings，选择初始化

方式为 VERTICAL DEPTH_AVE NOEQUIL。 

 

 

93） OK，回到 Builder 界面，点击 Specify Property，通过下拉菜单

选择 Oil Mole Fraction（Soln_Gas），并在 Whole Grid 中输入 1.0，代表

油相为 100% Soln_Gas。OK 两次。也可以在文本编辑器中实现，打开

文件 EXERCISE_1_HDR_STARS.dat，并查找 MFRAC 关键字，以便将

组分 Soln_Gas 的摩尔分数调整为 1.0。 
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94） 在文本编辑器中，使用查找选项查找粘度表 VISCTABLE，删

除非线性粘度混合规则关键字（高亮部分）。 

 

95） 保存文件。 
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14. 计算 STARS 地热开采模型 

96） 回到 Launcher，将 EXERCISE_1_HDR_STARS.dat 拖到 STARS

模拟器上。点击 OK 开始运行。（如果运行报错，提示 WATER_GAS 无

法识别，这是由于由 IMEX 转到 STARS 过程中，未能将此关键字删除

导致的，可以在文本编辑器中，直接搜索 VERTICAL DEPTH_AVE 

WATER_GAS NOTRANZONE EQUIL 并删除即可） 

 

15. 地热开采模拟结果分析 

97） 将结果文件 EXERCISE_1_HDR_STARS.irf 拖到 Results Graph

图标上。 

98） 添加生产井 EnergyRate（能量产出速度）曲线，如下图。从曲

线可以看出，随着注入水的增加，产出的热量逐渐减小。 
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99） 在 Results 3D 中打开 EXERCISE_1_HDR_STARS.irf 文件，并显

示含水饱和度 Water Saturation 场图，选择模拟结束时间 2010-01-01，

显示第 6 层，并将色标范围更改为从 0.1 开始。可以观察到，生产井开

采出的水全部来自注入井。 
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100） 从下拉菜单中更改属性并显示 Temperature 温度，将色标更改为

从 150°C 开始。 
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